
User Guide

•	 Right-to-Know Label Software   7
•	 GHS/HazCom 2012 Label Software   15
•	 Arc Flash Label Software   27
•	 Pipe Marking Software   32
•	 Label Design Software   40



Minimum Requirements
Operating System: Windows XP, Windows Vista, Windows 7, Windows 8, Windows 10

Memory: 64MB RAM

Hard Drive: 300MB, CD-ROM Drive

Minimum Screen Resolution: 800 x 600

DuraSuite Videos
DuraSuite™ Labeling Software gives you the ability to make a wide range of labels. This 
guide describes your many options for designing and producing labels — from die-cut arc 
flash labels to ammonia pipe markers.

To help you create effective labels and signs, Graphic Products has several instructional 
videos that explain how to use the various DuraSuite modules.

You can view the videos at this web page:  
duralabel.com/durasuite/durasuite-videos.php

Specifications and information contained in this manual are furnished for informational use only, and are subject 
to change at any time without notice, and should not be construed as a commitment by Graphic Products. Graphic 
Products assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual.

Graphic Products®, DuraLabel®, PathFinder®, Toro® and Lobo® are Registered Trademarks of Graphic Products, Inc.  
© 2008, 2016 Graphic Products, Inc.
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Introduction 
DuraSuiteTM Labeling Software expands your creative capabilities, simplifies safety 
compliance and lets you produce professional-looking labels for virtually any application.

This guide is organized by label type and software function, walking you step-by-step through 
the label-making process so that you can make the label you need as quickly as possible.

RTK Labels—DuraSuite includes information about more than 1,700 chemicals. The 
database includes Chemical Abstract Service (CAS) numbers, NFPA Hazard Index numbers, 
Signal Words, Health Hazards, Organ Hazards and PPE Pictograms1. You can use the 
information in the database or modify it based on the information in the Safety Data Sheets 
you receive (refer to Section 3).

Globally Harmonized System (GHS) and HazCom 2012 Labels—
Make GHS labels and HazCom 2012 labels with these DuraSuite modules. Choose from 
1,500 chemical records and automatically populate your label with preloaded hazard 
pictograms, signal words, hazard statements and precautionary statements. GHS labels 
comply with the GHS standard and the HazCom 2012 labels comply with the OSHA 
HazCom 2012 Final Rule (refer to Section 4). 

Arc Flash Labels—DuraSuite includes a database for storing arc flash labels you 
create. Just fill in the blanks on the label template and select the appropriate personal 
protective equipment (PPE) and your arc flash labels are ready to print. Labels can be 
created in English, French or Spanish (refer to Section 5.2.5).

Pipe Markers—The Pipe Marking module lets you create custom pipe markers based 
on ANSI/ASME code. Just select the contents and pipe diameter and your pipe marker is 
ready to print (refer to Section 6).

DuraSuite also includes an Ammonia Pipe Marking module, which is based on IIAR 
standards. A tab for previewing and printing physical state/pressure level labels and a tab for 
creating arrow wraps are included in the Ammonia Pipe Marking module (refer to Section 7).

Custom Labels—Use the Label Designer module to create custom labels for any 
application, from OSHA safety labels to wayfinding signs. The easy-to-use multi-function tool 
box provides options for setting label size and orientation, and adding text and images.

If you need additional assistance setting up or using DuraSuite Labeling Software, please 
visit our website at DuraLabel.com, or call us at 800.788.5572.

USeR AnALyTICS: DuraSuite includes an optional feature to share anonymous data 
about your usage of the program with our development team. To toggle this feature, 
or to read the most current statement for how we use this information, go through the 
Tools menu to select Options, and click on the Privacy tab.

1The words “pictogram” and “symbol” are used interchangeably in this guide.



2   DuraLabel.com | 800.788.5572

Contents
1. Using DuraSuite Labeling Software   4

1.1 DuraSuite Labeling Software Toolbar and Menu Bar   4
1.2 DuraSuite Labeling Software Display and Edit Modes   5

2. Getting Started   6
2.1 Label Types   6

3. Right-to-Know (RTK) and Chemical Identification Labels   7
3.1 Selecting an NFPA Label from the Database   7
3.2 Searching Chemicals in the Database   8

3.2.1 Resizable Search Results List   9
3.3 Editing an Existing Label   9
3.4 Creating a New Label   9
3.5 Populating a Label   10

3.5.1 Populating Information fields   10
3.5.2 Health Hazard Selection   11
3.5.3 Organ Hazard Selection   11
3.5.4 Symbol Selection   12
3.5.5 Importing New Symbols   13
3.5.6 Display/Hide Pictograms   13
3.5.7 Saving a Label   14
3.5.8 Saving Changes to an Edited Label   14

4. Globally Harmonized System (GHS) and HazCom 2012 Labels   15
4.1 Module Selection Screen   15
4.2 Label Display   16

4.2.1 Label Size and Layout   16
4.3 Searching Chemical Records   16

4.3.1 Search by Name or Identification Numbers   17
4.4 Editing a Label   18

4.4.1 Advanced and Basic Edit Mode   18
4.5 Creating a New Chemical Label   19
4.6 Populating a Chemical Label   19

4.6.1 Chemical Name, CAS, EC and UN Numbers   19
4.6.2 Hazard Statements   20
4.6.3 Precautionary Statements   21
4.6.4 Content Size Warning Outline   22
4.6.5 Supplemental Information   22
4.6.6 Supplier Identification   22
4.6.7 Signal Words   23
4.6.8 Hazard Pictograms   23

4.7 Languages   24
4.8 Printing GHS/HazCom 2012 Labels   25

4.8.1 Blacked-Out Diamonds on HazCom 2012 Labels   25
4.8.2 Driver Settings and Printing   26

5. Arc Flash Labels   27
5.1 Arc Flash Toolbar   27
5.2 Data Entry and Editing   28

5.2.1 Equipment Name and Project   28
5.2.2 Incident Energy or PPE Category   28
5.2.3 Choosing PPE   28



DuraLabel.com | 800.788.5572    3

contents

5.2.4 Date of Assessment   28
5.2.5 Languages   28
5.2.6 Saving and Editing Labels   29

5.3 Importing Data from a Spreadsheet   29
5.3.1 Preparing a Spreadsheet   29
5.3.2 Importing Data   29
5.3.3 Advanced: Using ODBC Connections   30

5.4 Finding a Saved Label   30
5.4.1 The Search Bar   30
5.4.2 Project Filters   31

5.5 Printing Arc Flash Labels   31
5.5.1 Before You Print   31
5.5.2 Print and Print Special   31

6. Pipe Markers   32
6.1 Creating a Pipe Marker   32

6.1.1 Automatic Pipe Marker Design   33
6.1.2 Custom Sizing   33
6.1.3 Printing Pipe Markers   34

6.2 Arrow Wrap Tab   35
7. Ammonia Pipe Markers   37

7.1 Creating an Ammonia Pipe Marker   37
7.1.1 Ammonia Pipe Marker Design   37

8. Label Designer   40
8.1 Navigating the Label Designer   40

8.1.1 Label Designer Toolbar   40 
8.1.2 Label Designer Tool Box   42 
8.1.3 The Label Canvas   42 
8.1.4 File Controls   43 

8.2 Designing a Label Template    44
8.2.1 Basic Object Controls   44 
8.2.2 Objects on the Label   45 
8.2.3 Additional Object Controls   48

8.3 Automatically Updating Content   49
8.3.1 Manually Setting up a Sequence   50 
8.3.2 Importing Data from a Spreadsheet   50
8.3.3 Choosing a Label and Printing   51

9. Tools   52
9.1 Tools Menu   52

9.1.1 Calibration   52
9.1.2 Options   52

10. Printing Labels   54
10.1 Quick Print   54
10.2 Print Special   54

10.2.1 Print All   54
10.2.2 Print Current Selection   55
10.2.3 Print Custom   55
10.2.4 Print Sign   55

10.3 Printing Photos or Colored Images   55



4 | 1.1 DuraSuite Labeling Software Toolbar and Menu Bar   DuraLabel.com | 800.788.5572

1. Using DuraSuite Labeling Software
DuraSuite Labeling Software is the easy way to create informative labels and signs. 
Intuitive toolbars and menu options let you control dimensions and other options while 
dialog boxes lead you through the label-building process. DuraSuite comes preloaded 
with over 1,300 symbols. 

1.1 DuraSuite Labeling Software Toolbar and Menu Bar
DuraSuite’s toolbar includes options for creating a variety of labels: arc flash, RTK, GHS/
HazCom, arc flash, pipe markers, or custom labels. The following tools are shown on 
each label’s toolbar or menu bar, though not every tool is used for every type of label. 
Tools not applicable to a label type are grayed out.

1 2 3 4 5

6 7 8 9 10 11 12 13 14 15 16 17 18 19

1. File provides file and print options or lets you exit the program. 

2. Edit lets you undo, redo, cut, copy, paste or delete a label, or switch to  
 edit mode.

3. Tools contains options for module settings and calibrating* label position.

4. Help shows basic software information and lets you check for updates.

5. Search By specifies what field is to be searched, e.g., name or CAS number.

6. New Label starts a new label with blank fields.

7. Edit Label enters edit mode for an existing label.

8. Save Label saves a label to the database or file system.

9. Delete Label erases the label from the database.

10. Show/Hide Symbols toggles between showing hazard pictograms and  
 hazard keywords/comments on RTK labels.

11. Quick Print prints the current label.
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Using DUrasUite LabeLing software

12. Print Preview lets you preview the printed label layout.

13. Change Database lets you toggle between databases (in modules which  
 contain multiple databases, such as GHS).

14. First Record jumps to the first label in the database or search results (or hit F5).

15. Previous Record goes back one record in the database or search results (or hit F6).

16. Next Record goes forward one record in the database or search results (or hit F7).

17. Last Record jumps to the last label in the database or search results (or hit F8).

18. Module Select brings up dialog box containing module selections to let  
 you switch between label types.

19. Label Drop-Down Menu lets you select specific label type and size.

1.2 DuraSuite Labeling Software Display and Edit Modes
DuraSuite separates its functionality into two modes. The default mode is Display, which 
shows the layout of a label. In some modules, Display mode will also let you make 
changes to the layout. When available, you can make changes to the size, position and 
font of label elements in Display mode.

In Edit mode, you can change the text on a label, usually without affecting the layout. 
Label content, such as text fields, is usually changed in Edit mode.
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2. Getting Started
When opening the DuraSuite Labeling Software, you’re presented with DuraSuite’s 
opening splash menu. Once you’ve determined the type of label you want to create, click 
on the corresponding icon, then select the label size you want from the dialog box that 
appears. 

DuraSuite’s opening splash menu

2.1 Label Types
You can create many types of labels and signs with DuraSuite Labeling Software, 
including Arc Flash, NFPA, Right-to-Know Color Bar, Pipe Markers/Ammonia Pipe 
Markers, GHS, HazCom 2012, and custom labels. All are discussed in this guide.

DuraSuite Labeling Software prints:

•	Arc Flash labels: 4 sizes 

•	NFPA labels: 7 layouts

•	RTK Color Bar labels: 4 layouts

•	Pipe Marking labels, including Ammonia Pipe Markers (customizable layouts)

•	HazCom 2012 labels: 10 layouts

•	GHS labels: 5 layouts

•	Custom labels using the Label Designer Module
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3. Right-to-Know (RTK) and Chemical  
	 Identification	Labels
RTK labels provide important information about workplace 
chemicals and hazards for the benefit of employees, visitors and 
end users. 

NFPA labels provide critical information for emergency 
responders. RTK Color Bar labels provide information everyone 
can understand in non-emergency situations.

DuraSuite lets you use existing chemical information stored in 
its database or enter chemical and associated information manually. It provides pre-
designed label templates that match various sizes of DuraLabel RTK die-cut labels.

NOTE: RTK label instructions contained in this guide apply to both NFPA and RTK Color 
Bar labels.

3.1 Selecting	an	NFPA	Label	from	the	Database
To select an NFPA label from the DuraSuite database, click on the NFPA Diamond icon 
displayed in the Module Selection box. (To select an RTK Color Bar label, click on the 
RTK Color Bar icon.) 

A screen showing seven NFPA label sizes appears. Click on the size of NFPA label you 
want to create.

The label template you chose now appears.

RTK Color Bar label



8 | 3.2 Searching Chemicals in the Database   DuraLabel.com | 800.788.5572

RTK and ChemiCal idenTifiCaTion labels

3.2 Searching	Chemicals	in	the	Database
To find the chemical name you want on your label:

A. Select Name or CAS number as the search category from the Search By drop-down 
menu (A on graphic below).

B. Enter the chemical name or CAS number in the Search box (B on graphic below), 
depending on your previous selection.

C. Browse through the database using the navigation buttons (C on graphic below), 
using the F5 through F8 keys, or by selecting an item from the  
drop-down search results (D on graphic below).

The first search result is immediately displayed on the label. The status bar along the 
bottom of the screen (E on graphic above) displays the number of records that match 
the search criteria entered, e.g., “S”: “Found 117 records Displaying result number 1.”

NOTE: You can expand your search by placing 
an asterisk (*) at the beginning of your search 
string. This allows your string to be matched 
at any position in a chemical name or CAS 
number. For example, a search by chemical 
name for “*ban” yields the terms “Banana Oil,” “Dursban,” “Essence of Mirbane,” 
“Tetraethylplumbane” and “Tetramethylplumbane.”

D

E

A B

C
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RTK and ChemiCal idenTifiCaTion labels

3.2.1 ReSIzAbLe	SeARCh	ReSuLtS	LISt
When you use the Search box to find a term, a 
drop-down list appears. This drop-down list is 
resizable so that you can see more of the search 
results. The resizing control is indicated by the two 
diagonal lines in the lower left corner of the search 
results box. To resize the box, click and drag the 
resizing control. 

3.3 editing	an	existing	Label
Any information in DuraSuite Labeling Software’s 
chemical database can be edited for an NFPA or 
RTK Color Bar label at any time.

To begin editing an existing label, click the 
Edit Label button on the toolbar. Information 
on the existing label can now be altered by 
following the instructions described in Section 
3.5, “Populating a Label,” which applies both 
to creating a new label as well as editing an 
existing label.

NOTE: All chemical information is shared between different label formats so editing an 
existing label will affect any other templates using that chemical information.

3.4 Creating	a	New	Label
If after searching you are unable to find a specific 
chemical in the database, you can enter the label 
information you want by clicking the New	Label 
button on the DuraSuite toolbar. Label information 
previously displayed is replaced with data entry 
boxes for the Chemical Name, Chemical Abstracts 
Service number (CAS), Signal Word, Health 
Hazards, Organ Hazards and PPE Pictograms.

NOTE: Select 4" x 6" NFPA Diamond from the label drop-down menu. This will 
preformat chemical information for all other RTK and NFPA label formats.

Search results resizing control

NFPA label with editable fields 

A new label with empty fields
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RTK and ChemiCal idenTifiCaTion labels

You are now ready to change or add information to these boxes and set the NFPA 
Hazard Index Numbers.

NOTE: The same procedures are used to edit an existing label.

3.5 Populating	a	Label

3.5.1 PoPuLAtINg	INFoRmAtIoN	FIeLDS
Follow these steps to populate your 
label’s information fields:

A. Enter the Chemical Name, an 
alphanumeric string of no more 
than 255 characters, in the 
Chemical Name section.

B. Enter the Chemical Abstracts 
Service number in the CAS # box.

C. Select the appropriate signal word from the drop-down list.  

D.	 Enter NFPA Hazard Index Numbers in the Fire Hazard (red), 
Health Hazard (blue), and Instability (yellow) boxes by using 
their corresponding arrows. To set Specific Hazard(s), 
place a checkmark in the box(es) next to the item you 
want included, using the scroll bar to view the full list. 
Multiple Specific Hazards may not fit into the area 
provided by the label template. This will happen more 
frequently for the smaller labels. In this case a larger 
label template should be selected. If no Specific Hazard 
is selected, it will be displayed as a dash (-).

NOTE: Edit mode performs the same function as New Label mode; the difference is that 
in Edit mode fields are already filled with pre-populated data.

DuRASuIte	is preloaded with a comprehensive list of health and organ hazards, 
warnings and cautions, as well as numerous PPE, direction, information and warning 
pictograms.

Enter the Chemical Name in this field

Enter the CAS # Select signal word
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RTK and ChemiCal idenTifiCaTion labels

3.5.2 heALth	hAzARD	SeLeCtIoN
To add an item to a label’s Health Hazard section, click the button by the Health 
Hazards box.

The Health Hazards Selection dialog box appears, containing two sections: an 
“Available” section, including a list of descriptions, conditions and instructions from 
which to choose, and a “Selected” section.

Highlight the chosen item(s) in the Available list and move it to the Selected section 
using the appropriate arrows, shown below. 

Hazard and Pictogram Selection arrowS
Adds the highlighted item from the Available list to 
the Selected list.

Removes the highlighted item from the Selected 
list.

Adds all items from the Available list to the 
Selected list.

Removes all items from the Selected list.

To remove an item from the Health Hazard section, 
highlight the chosen item(s) in the Selected list and 
move it to the Available list using the appropriate arrow.

To add a new health hazard term to the list, click the 
Add button. The Add to Health Hazard Selection dialog 
box appears. Enter one new health hazard term per 
line. 

When finished adding new health hazard terms, 
click OK  and the new items are added to the list of 
available terms.

3.5.3 oRgAN	hAzARD	SeLeCtIoN
To add an item to the Organ Hazards section, click the 
button by the Organ Hazards box. 

The Organ Hazard Selection dialog box appears, 
containing two sections: an “Available” section, 
including a list of body parts and systems from which 
to choose, and a “Selected” section.

Click this button to 
add a new item.

Click this button to 
add a new item.
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RTK and ChemiCal idenTifiCaTion labels

Highlight the chosen item(s) in the Available list and move it to the Selected list using 
the appropriate arrow. 

To remove an item from the Organ Hazard section, highlight the item in the Selected list 
and move it to the Available list using the appropriate arrow.

To add a new organ hazard term to the list, click the 
Add button. The Add to Organ Hazard Selection dialog 
box appears. Enter one new organ or system term per 
line. 

When finished adding new organ hazard terms, click 
OK and the new items are added to the list of available 
terms.

3.5.4 SymboL	SeLeCtIoN
Symbols may be added to labels at least 3" x 5" in size. To add a PPE, direction, 
information or warning pictogram to the pictogram section, click the button to the right 
of the pictogram box. 

A Symbol Selection dialog box appears, 
containing two sections: an “Available” section, 
including a list of pictograms from which to 
choose, and a “Selected” section.

Highlight the chosen item(s) in the Available 
list and move it to the Selected list using the 
appropriate arrow. 

To remove an item from the pictogram section, 
highlight the item in the Selected list and move it 
to the Available list using the appropriate arrow.

Click this button to add a new pictogram.
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RTK and ChemiCal idenTifiCaTion labels

3.5.5 ImPoRtINg	New	SymboLS
To add to the available symbols, DuraSuite lets you import images from your hard drive.

To import new symbols, click the button to the right of the pictogram box. A Symbol 
Selection dialog box appears, containing two sections: an “Available” section and 
“Selected” section. 

Click on the	Import button just below the Available section. A file dialog box appears. 

Select the image you want to add and click the Open button. The new image is added to 
the Available list.

NOTE: DuraSuite supports the import of full-color images, but output color will be 
determined by ribbon color, not screen colors. Full-color printing is supported by the 
DuraLabel Catalyst color printer.

3.5.6 DISPLAy/hIDe	PICtogRAmS
On labels 3" x 5" or 
larger, pictograms can be 
replaced by a Comments 
section, providing the 
option of having either 
pictograms or text 
displayed on the label.

Choose between the two 
layout scenarios by clicking the Show/
hide Symbols button on the toolbar. 
This button toggles between showing 
pictograms or showing a Comments section. 2" x 2" and 1" x 3" NFPA Diamond labels do 
not display pictograms or comments due to size constraints.

File dialog boxImport button

Display either a 
pictograms section or 
a comments section
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RTK and ChemiCal idenTifiCaTion labels

3.5.7 SAvINg	A	LAbeL
To save a label, click the Save button. The label is now saved to the database and the 
current mode switches to Display. 

leaving new label mode witHout Saving
To leave the New Label mode, click the New	Label button while a new label is open. A 
dialog box appears, asking if you would like to save the changes.

If “Yes” is clicked, the label is saved and displayed. If “No” is clicked, the information 
that was added is discarded and the first chemical in the current search is displayed. 

3.5.8 SAvINg	ChANgeS	to	AN	eDIteD	LAbeL
Save changes to an edited label by clicking the 
Save button. The changes are saved and the 
edited label is displayed. the	saved	label	will	
permanently	overwrite	the	original	label.	

To add a new label without overwriting the 
original label, go to File	>	Save	As. 

A Save Record As dialog box will appear. The chemical name of your label will 
automatically appear under the Chemical Name. Click the OK button. The label is now 
saved to the database and the current mode switches to Display.

NOTE: Changing the Chemical Name in the Save Record As dialog box will also change 
the chemical name on your label.

leaving edit mode witHout Saving
To exit the Edit mode without saving changes, click the edit	Label button. 

A dialog box appears, asking if you would like to save changes. Click “No.” The changes 
are discarded and the original label is displayed.

For printing instructions, see Section 10, “Printing Labels”.

Save Record As dialog box
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4. Globally Harmonized System (GHS) and  
 HazCom 2012 Labels
DuraSuite Labeling Software lets you create labels that comply with international and 
domestic labeling requirements. 

There are two GHS label modules: 

•	HazCom 2012: this module is for creating compliant chemical 
hazard labels for use within the United States

•	GHS: this module is for creating compliant chemical hazard 
labels for use internationally

Both template formats contain 
primarily the same information, but 
they vary in their visual designs. 
These differences may make them 
non-compliant if the wrong layout is 
chosen. Layout should be selected 
based on the final destination of 
the chemical being labeled. 

DuraSuite’s database contains approximately 1,500 pre-loaded chemical records used 
to populate the various fields of both the GHS and HazCom 2012 templates. You can 
edit existing chemical records and add new records. 

DuraSuite provides a comprehensive list of Hazard Statements, Precautionary 
Statements and Pictograms (as provided by the European Union); making it easy to edit 
chemical information and create new compliant chemical labels.

4.1 Module Selection Screen 
When you open DuraSuite, you will see the 
Module Selection screen. Click on Globally 
Harmonized System. This will take you to another 
selection screen, where you can click either GHS 
International or HCS/HazCom 2012.

Examples of GHS and HazCom 2012 labels in 4" x 6" and 9" x 4"

Module selection screens
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GHS and Hazcom 2012 LabeLS

4.2 Label Display
HazCom 2012 and GHS labels contain similar information. This information includes:

D

D

F F

G G

H

B BC C
E E

AA

A. Name of chemical

B. Relevant chemical identification number (CAS, UN, EC)

C. Signal Word

D. Hazard Pictograms

E. Hazard Statements

F. Precautionary Statements

G. Supplier of material

H. Supplemental Information (only on GHS label)

The placement of the information may vary depending on 
the size of the label. 

4.2.1 LABEL SizE AnD LAyout
Select a label size and layout by selecting the layout drop-down menu from the toolbar. 

4.3 Searching Chemical Records
The chemical records in DuraSuite’s database are cataloged and searchable in several 
ways:

•	Name of chemical

•	CAS Number (Numbers assigned to chemicals by the Chemical Abstracts Service 
organization)

•	UN Number (Numbers assigned to chemicals by the United Nations)

•	EC Number (Numbers assigned to chemicals by the European Commission)

Layout drop-down menu
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GHS and Hazcom 2012 LabeLS

To search from the populated database, select the drop-down menu next to Database 
(A on graphic below). Click Browse, then double-click chemicals. To find a specific 
chemical, use the Search tools located on the right side of the toolbar.

4.3.1 SEARCH By nAME oR iDEntiFiCAtion nuMBERS
To find the chemical name you want on your label:

A. Select Name or the identification number as the search category from the Search 
By drop-down menu (B on graphic below).

B. Enter the chemical name or number in the Search box, depending on your previous 
selection (C on graphic 
below).

C. Browse through the 
database using the 
navigation buttons (D on 
graphic at right), using the 
F5 through F8 keys, or by 
selecting an item from the 
drop-down search results (E 
on graphic at right).

The first search result is 
immediately displayed on the 
label. The status bar along the 
bottom of the screen (F on graphic above) displays the number of records that match 
the search criteria entered, e.g., “S”: “Found 145 records Displaying result number 1.”

notE: You can expand your search by placing an asterisk (*) 
at the beginning of your search string. This allows your string 
to be matched at any position in a chemical name or chemical 
identification	number.	For	example,	a	search	by	chemical	name	
for “*acid” yields the results “Dichlorophenoxyacetic acid”, 
“Ethylhexanoic acid” and more. Just searching for “acid” without the asterisk returns 
no results because it is only searching for “acid” at the beginning of the chemical 
name.

D

F

B C

EA
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GHS and Hazcom 2012 LabeLS

Resizable seaRch Results list
When you search for a term in the Search box, a drop-down 
search results list appears below. This drop-down list is 
resizable so that you can see more of the search results. The 
resizing control is indicated by the two diagonal lines in the 
lower left corner of the search results box. To resize the box, 
click and drag the resizing control.

4.4 Editing a Label
All information on a label can be edited. To edit an existing label, click the Edit Label 
button on the toolbar or use the Ctrl+E shortcut. Specific instructions on how to edit the 
label fields are in Section 4.6, “Populating a Chemical Label.” 

iMPoRtAnt! Editing and saving an existing chemical will overwrite that chemical’s 
information in the database. If you don’t want to overwrite an existing entry but want 
to create a new entry, you must create a new label. GHS and HazCom 2012 share the 
same database, so changes to one module will affect both.   
 
Deleting records: Using the Delete button on a chemical label will delete that 
chemical from the database. Only press the Delete button if you are certain you will 
no longer need to use that chemical record. To restore a deleted record, either create 
a record from scratch or reload the DuraSuite library, which will overwrite any custom 
labels you have created.

4.4.1 ADvAnCED AnD BASiC EDit MoDE
There are two edit modes for the two GHS-aligned modules: Basic Edit and Advanced 
Edit. 

The Basic Edit mode is the default mode available when a new label is created. The 
Basic Edit mode is the easiest method of creating a label because it automatically 
populates the hazard pictograms, hazard statements and the signal word based on your 
choice of hazard categories. 

The Advanced Edit mode allows you to manually change the hazard pictograms, hazard 
statements and the signal word. Unlike Basic Edit mode, these fields are not populated 
automatically. 

The Advanced Edit button is located on the far left side of the 
toolbar. Click on the button to toggle back and forth between 
Advanced and Basic Edit modes. When the button has a blue 
rectangle around it, it is in Advanced Edit mode. Advanced Edit button

Search results resizing control
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iMPoRtAnt! For some labels created in Advanced Edit mode, it won’t be possible to 
enter Basic Edit mode. This happens with labels that have hazard statements that 
belong to more than one hazard category, or when converted hazard categories belong 
to the same hazard class.

4.5 Creating a new Chemical Label
If you are unable to find the chemical you are looking for, you can create a new chemical 
entry by clicking the new Label button on the DuraSuite toolbar. This creates a new 
label with blank, editable fields. 

4.6 Populating a Chemical Label
The following sections will describe how to enter and change information in the label 
fields. This process is almost the same whether you are creating a new label or editing 
an existing label. (The major difference is that if you are editing an existing chemical, the 
label fields will already have information present.) To make changes to these fields, you 
must be in either Create New Label mode or Edit Label mode. 

notE: If you are creating a new label or editing an existing label, a Safety Data Sheet 
(SDS) will contain the relevant information you need to populate the label.

The GHS label and the HazCom 2012 label have different layouts, but the information 
they contain is very similar. In most of the following sections you will see images of both 
labels, so that you can see how the instructions apply to both labels.

4.6.1 CHEMiCAL nAME, CAS, EC AnD un nuMBERS
These fields contain the name of the chemical and the relevant chemical identification 
numbers.  

Chemical Name,
CAS #, EC #, UN #

HazCom 2012 label GHS label
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4.6.2 HAzARD StAtEMEntS

iMPoRtAnt! Hazard/Precautionery Statements should only be edited by users 
familiar with compliance requirements. These statements are compliant by default so 
customization is not recommended.

DuraSuite’s database includes the entire library of hazard statements as provided by 
the European Commission for the Globally Harmonized Standard. 

To edit hazard statements, click the edit button to the right of the Hazards Statements 
field. Depending on whether you are in Basic Edit mode or Advanced Edit mode (see 
Section 4.4.1, “Advanced and Basic Edit Mode”, for more information), clicking this 
button will bring up one of two selection windows. 

hazaRd statements in basic edit mode
If you are in Basic Edit mode (the default mode 
when you create a new label), clicking the edit 
button next to Hazard Statements will bring up a 
Hazard Classes/Categories selection window. This 
window will allow you to select hazard categories, 
which are associated with pre-defined hazard 
statements, hazard pictograms and signal words. 

Expand the hazard heading by double-clicking 
the heading (e.g., Flammable liquids). You can 
expand all hazard headings by clicking the 
Expand All button. You can also collapse all 
hazard headings by clicking the Collapse All button.

Using your chemical SDS as a guide, click the box next to the desired hazard categories. 
The selected hazard statements will appear in the bottom part of the window, indicating 
they are chosen. When you are finished selecting hazards, click oK. 

The hazard pictograms, statements and signal word will be automatically populated on 
the label, based on your choices of hazard categories.

Hazard Statements menu in Basic Edit mode

Hazard Statement

HazCom 2012 label GHS label
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hazaRd statements in advanced edit mode
If you are in Advanced Edit mode, the Hazard 
Statements menu will allow you to choose 
hazard statements from the complete list of 
statements.

Using your chemical SDS as a guide, select 
the appropriate hazard statements. To select 
a statement, either click the box next to 
the desired statement, or double-click the 
statement. Each statement selected will 
appear in the bottom half of the window.

When you are finished selecting statements, 
click oK. The hazard statements you chose now appear on your label template.

notE: Advanced Edit mode allows you to choose hazard statements without regard to 
the hazard categories. Also, Advanced Edit mode does not automatically populate the 
hazard pictograms and signal word based on your hazard statement choices. Because 
of this, the Advanced Edit mode requires a higher degree of knowledge to ensure 
edited labels meet chemical labeling requirements. 

4.6.3 PRECAutionARy StAtEMEntS
DuraSuite’s database includes the complete library of Precautionary Statements 
decided upon by the European Union.

Hazard Statements menu in Advanced Edit mode

Precautionary Statements

HazCom 2012 label GHS label
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To add precautionary statements to your 
label, click the button to the right of the 
Precautionary Statements field to open the 
Edit Precautionary Statements window and 
then select appropriate entries from the menu 
that appears. With your choice highlighted, click 
the arrow to the right of the menu or double-
click on the selected statement(s). When you are 
finished selecting statements, click OK.

The entries you chose now appear on your label 
template.

4.6.4 ContEnt SizE WARninG outLinE
Sometimes the Hazard Statements or Precautionary 
Statements for a chemical will be too long to fit into the 
area provided by the label template. This will happen 
more frequently for the smaller labels. DuraSuite lets you 
know that the statements do not fit by filling the area 
with yellow as an alert. 

An authorized person at your facility may decide how to edit the content to make it fit on 
the label while remaining in compliance. 

4.6.5 SuPPLEMEntAL inFoRMAtion
The Supplemental information field is only available in 
the GHS module. This optional field lets you supplement 
your label’s hazard and precautionary statements. It 
can contain cautionary statements or anything deemed 
relevant to the work environment. 

4.6.6 SuPPLiER iDEntiFiCAtion
You must include the chemical supplier’s name and contact information on GHS and 
HazCom 2012 labels. 

Supplemental Information (only available 
on GHS label)

Precautionary Statements menu

Content Size Warning

Supplier  
Identification

HazCom 2012 label GHS label



DuraLabel.com | 800.788.5572    4.6 Populating a Chemical Label | 23

GHS and Hazcom 2012 LabeLS

To edit the supplier information, click the button to 
the right of the Supplier information field to open 
the Edit Supplier information window. Enter the 
chemical supplier’s name, address and telephone 
number in the fields provided.

When finished, click oK. The supplier’s name is 
displayed on your label template and stored in the 
DuraSuite database. Whenever that same supplier 
is selected for other labels, the Supplier Information 
fields will be automatically populated with that 
supplier’s saved information.

notE: Supplier information will display differently on different labels. Some labels will 
have	more	room	to	fit	more	supplier	information.	Other	labels	will	have	less	room	and	
display less supplier information.

4.6.7 SiGnAL WoRDS 
In Basic Edit mode (the default mode when creating a new label), the signal word cannot 
be manually changed because it is populated based on the chosen hazard statements. 
The signal word can only be changed in Advanced Edit mode. Changing the signal word 
should only be done by an authorized person at your facility.  

To change the signal word in Advanced Edit mode, use the Signal Word drop-down menu 
to select either Danger or Warning. Your choice will be saved when you save the label.

The Edit Supplier Information window provides 
fields for entering your chemical supplier’s name, 
address, telephone number and more.

Signal Word

HazCom 2012 label GHS label

4.6.8 HAzARD PiCtoGRAMS
In Basic Edit mode (the default mode for creating new labels), 
DuraSuite automatically populates the hazard pictograms 
based on the hazard statements that have been selected. 
In Advanced Edit mode (the default mode for editing 
existing chemical labels), you can add or remove pictograms manually. Changing hazard 
pictograms should only be done by an authorized person at your facility.

To edit pictograms in Advanced Edit mode, click the button to the right of the pictogram 
area to open the Edit Hazard Pictograms menu.

Signal Word drop-down menu
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Move the pictograms you want on your label from the 
Available section to the Selected section by double-
clicking it or using the arrow provided. You can also 
remove a pictogram from the Selected section by 
double-clicking it or using the appropriate arrow. 

Click oK to add the selected pictograms to your label. 

If you are finished editing your label, click the Save 
Label icon on your toolbar to save and display your label. 

DuraSuite allows a GHS label to display a maximum of four hazard pictograms. (This is 
because regulations require a specific ratio of hazard pictogram size to label surface 
size.) The HazCom 2012 labels can display a maximum of five pictograms.  

notE: If you require more hazard pictograms than the label templates can support, 
contact Graphic Products for assistance.

4.7 Languages
DuraSuite’s GHS-aligned chemical database has 
information (such as precautionary statements and 
hazard statements) in several languages. This allows 
you to switch back and forth easily between languages.

The Language Selection menu is on the right side 
of the toolbar. Clicking on this menu will show the available languages in a drop-
down menu. Selecting a language will automatically switch any applicable preloaded 
information to the chosen language.     

iMPoRtAnt! DuraSuite does not have the ability to translate user-provided text. It only 
has the ability to switch between its stored translations. 

Hazard Pictograms

HazCom 2012 label GHS label

 Choose from a total of 11 pictograms

Language Selection menu
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4.8 Printing GHS/HazCom 2012 Labels

notE: This section does not apply to the DuraLabel Catalyst. For instructions on using 
that printer with the GHS/HazCom 2012 module of DuraSuite, please refer to the 
DuraSuite supplemental guide included with your DuraLabel Catalyst printer.

When preparing to print, be sure your DuraLabel printer is loaded with the correct 
supply size and type. GHS and HazCom 2012 labels require a special supply, with red 
diamonds pre-printed. The number of pictograms on the label will vary by chemical, and 
the supply for GHS labels must have the correct number of diamonds to match those 
pictograms.

4.8.1 BLACKED-out DiAMonDS on HAzCoM 2012 LABELS
For OSHA compliance, it is permissible to black out any extra diamonds on a HazCom 
2012 label that would otherwise be empty (having no corresponding pictogram). This 
allows the use of label stock with up to five diamonds pre-printed, even when the 
chemical being labeled only needs one pictogram.

To take advantage of this option, go through the Tools menu to select Options. On the 
Module Settings tab of this window, check the box for “Force template to specific symbol 
count,” and choose the number of diamonds that are pre-printed on your label stock. 
Then, click OK, and continue printing.

Before: Label design only uses three diamonds. 
This will not print correctly on four-diamond 
label stock.

Under Module Settings,  
force the template to use  
four-diamond label stock.

After: The design is rearranged, and the fourth 
diamond is blacked-out.
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4.8.2 DRivER SEttinGS AnD PRintinG
Both GHS and HazCom 2012 label stocks for most of the DuraLabel printers use a 
special black-marked backing for label alignment. In order to print correctly, the printer 
will need to be set to look for those marks.

Select Print from the File menu. A Print Dialog box will appear; select your DuraLabel 
printer and click the Preferences button to check the printer’s settings. Make sure that 
the printer is set to use Labels with Marks. (For details on this setting, see your printer’s 
User Guide.)
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The Arc Flash module of DuraSuite uses a built-in database system to store and retrieve 
Arc Flash label data, keeping track of your entered information and displaying it in a 
compliant format.

The relevant standard for Arc Flash labels, NFPA 70E, is updated periodically. DuraSuite 
versions 1.6.3 and later are designed to help users comply with the 2015 edition of 
the standard, while earlier versions of DuraSuite were designed for use with the 2012 
edition. Contact your DuraLabel representative if you need help with a different version of 
DuraSuite.

To start working with Arc Flash labels in DuraSuite, choose Arc Flash from the program’s 
opening menu, then choose your label size. You will see the first label in your database (or 
a blank label, if no data has been entered.)

5.1 Arc Flash Toolbar
The Arc Flash module of DuraSuite has its own toolbar at the top of the window, just below 
the main DuraSuite toolbar.

1 2 3 4 5 6 7 8 

1. Header – select the Danger, Warning, or Caution header for your labels, or select no 
header if your label stock already has the header printed in place.

2. Options – toggle the optional Grid and Border lines on your label, and toggle 
showing the date on the label. Also, select either Incident Energy or Category for the 
presentation of the Arc Flash information.

3. PPE – modify the selectable list of PPE.

4. Import – automatically read information from an existing spreadsheet to create labels 
in the DuraSuite database.

5. Project Filter – choose to view all labels in your database, or only the labels within a 
specific set.

6. Project – identify which set of labels the current label belongs to. This information 
does not appear on the label itself.

7. Language menu – add, edit, or remove options from the Language selections.

8. Language selection – choose a language for the label’s static elements.
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5.2 Data Entry and Editing
To use DuraSuite’s Arc Flash module to create arc flash labels, simply click the  New 
Label button in the toolbar at the top of the screen. The fields on the label will become 
editable, and you can simply type the appropriate data into each field.

5.2.1 EquIPmENT NAmE AND PrOjEcT
Each label must have a unique Equipment Name, located in the lower left. You may also 
want to use the Project field in the toolbar to type in a project name, or select an existing 
project name. Grouping your labels into Projects will make it much easier to find a specific 
label in the database (described later in this guide).

5.2.2 INcIDENT ENErgy Or PPE cATEgOry
The 2015 edition of NFPA 70 clarified that a label may include either the 
general Arc Flash PPE Category, or the calculated Incident Energy and 
Working Distance, but not both. To choose which of those two elements 
will appear on your label, choose Show Incident Energy or Show Category, 
as appropriate, from the Options drop-down menu in the toolbar.

5.2.3 cHOOsINg PPE
To specify a list of required PPE, scroll through the list of PPE on the right side of the label 
and check the boxes for each appropriate element. If you have chosen to show the Arc Flash 
PPE Category, the list of PPE that is shown will update to match the recommendations for 
the category that you select with the Arc Flash PPE Category drop-down menu. You can also 
edit the list of PPE to adjust, remove, or add PPE elements using the  Add PPE button 
on the toolbar.

5.2.4 DATE OF AssEssmENT
By default, arc flash labels will include the Date of Arc Flash Risk Assessment in the lower 
right corner of the label. This can be disabled with the Show Date option in the Options 
drop-down menu in the toolbar. To change the date, click the down arrow next to the 
displayed date and choose a date from the calendar that appears, or choose Today to use 
the current date.

5.2.5 LANguAgEs
In addition to the dynamic information on the label, which is different for each piece of 
equipment, you may want to change the static text, such as the field titles and PPE names. 
These can be modified for different languages or facility preferences. There are three 
defaults included in DuraSuite: English, Spanish (Mexico), and French (Canada).

To choose an existing language entry, simply select it from the Language selection dropdown 
in the Arc Flash Toolbar. To add a new language entry, choose “New” in the Language menu 
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on the Toolbar; you will be prompted to name the new entry, and then type in the desired 
text for each field. You can edit or delete Language entries that you have created.

5.2.6 sAvINg AND EDITINg LAbELs
When finished with your label, click the  save button. The data will be included in 
DuraSuite’s built-in database for future re-printing or revision. If you want to edit the 
information in the label later, simply click the  Edit Label button, and the fields will 
become editable again.

If you edit the Equipment Name of a saved label, and then save the new changes, 
DuraSuite will add the new entry to its database instead of overwriting the old label. This 
can be used to quickly enter data for similar equipment.

5.3 Importing Data from a spreadsheet
Rather than entering all your data manually, you can import it into DuraSuite from an 
existing spreadsheet or database. DuraSuite can pull data directly from spreadsheets 
in .CSV (Comma-Separated Values), .XLS (Microsoft Excel), or .MDB (Microsoft Access) 
file types. Many electrical analysis programs can export data into one or more of these 
formats, or a spreadsheet may be assembled as part of an independent analysis.

DuraSuite can also use an ODBC connection to pull data from a variety of database 
systems. This is an advanced option, and will be covered at the end of this section.

5.3.1 PrEPArINg A sPrEADsHEET
Before you start the import process, ensure your 
spreadsheet is formatted properly. Use the first 
row of data for column headers. After that, each 
new row should correspond to a specific piece 
of equipment, with no blank rows. To use the 
checkbox-style PPE listings in DuraSuite, make a 
column for each type of PPE that your facility will 
use; type an X into cells for required PPE, and leave the cell 
blank for PPE that is not required for that equipment.

5.3.2 ImPOrTINg DATA
To begin an import, open the Arc Flash module of DuraSuite, and click the  Import 
button on the toolbar. Select the file type, and DuraSuite will prompt you to find the 
appropriate file or connection. Browse to the file, select it, and click Next to continue.

On the next screen, you will see a sample label with blank boxes on the left, and a list of 
the column headers from your data source on the right, with the information from your data 
source shown at the bottom of the window. Drag and drop each column header to the blank 

Import before 
filling blanks

After filling blanks



30 | 5.4 Finding a Saved Label   DuraLabel.com | 800.788.5572

Arc FlAsh lAbels

box where that data belongs. Depending on the layout of your spreadsheet and the data 
for your facility, some blanks may not be used, or some column headers may be used more 
than once. If some information will be the same on all labels, such as units of measurement 
or a project name, you can type that information into the appropriate boxes (before, after, or 
instead of a column header). When finished with this step, click Next to continue.

A sample label will show you how data has been imported, so 
you can check that information is going to the right places. If 
something is wrong, you can use the Previous button at the 
bottom of the window to go back a step and correct the problem. 
You can preview different labels from your spreadsheet with the 
directional arrows on the right. When finished with this step, click 
Next to continue.

DuraSuite will compare the new imported data to the existing data in DuraSuite’s arc flash 
database. If any of the equipment in your spreadsheet shares a name with equipment 
already in DuraSuite, you will be prompted to Rename the new entry, Overwrite the old entry 
with the new one, or Ignore the new entry and leave the old one in place. When all conflicts 
have been resolved, click the Finish button to complete the import process.

5.3.3 ADvANcED: usINg ODbc cONNEcTIONs
Open Database Connectivity (ODBC) lets developers and programmers pull data from a 
database management system and use that data in other software. DuraSuite can accept 
information this way as part of the Import process. Because ODBC connections require 
additional software and setup outside DuraSuite, check with your IT department if you 
have questions.

Once the external setup for ODBC has been completed, you can select “ODBC” as a data 
source in the beginning of the Import process. You will be prompted for a user or system 
Data Source Name (DSN), or you can choose to enter a connection string. Use the Test 
Connection button to confirm that the database link is working, and then click OK to 
continue. Once the ODBC connection is in place, the import process will continue as 
described above.

5.4 Finding a saved Label
As you enter more labels into DuraSuite’s database, you may have trouble finding a 
specific label for printing or editing. You can cycle through the labels in alphabetical order 
using the left and right arrow buttons near the top of the screen, but there are two other 
ways to find a specific label more quickly.

5.4.1 THE sEArcH bAr
If you are looking for a single, specific label, you 
can search by the Equipment Name using the search bar in the top right corner of the 

Review data on sample label

Use the search bar to find a specific label.
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DuraSuite window. Type in the first few letters of the Equipment Name, and click on the 
desired name when it appears in the list below the search box. 

5.4.2 PrOjEcT FILTErs
If you want to narrow your search to a single Project, browsing all of 
the labels in that set, use the Project Filter drop-down menu just above 
the displayed label. By default, this is set to Show All; if a specific 
Project is selected, only the labels from that Project will be shown.

5.5 Printing Arc Flash Labels

5.5.1 bEFOrE yOu PrINT
The Arc Flash Toolbar, at the top of the window, includes several important options that 
should be set before printing a label.

First, the Header drop-down menu lets you choose to have the Danger, Warning, or Caution 
header printed on your label. If your label stock already has the header text pre-printed, 
select no header. (If one is already selected, click it again and the header will disappear 
from the preview.)

Next, the Options drop-down menu lets you choose whether to include optional Grid or 
Border lines on your label. These graphical elements are not required, but may help make 
your label easier to read. If your label stock already has these lines preprinted, be sure 
these options are turned off.

If you are using the DuraLabel Catalyst full-color printer, be sure to turn on the option to 
“Print labels in full color.” To check this setting, go through the Tools menu to select Options, 
and then go to the Preferences tab. Click OK to continue if the setting is correct.

5.5.2 PrINT AND PrINT sPEcIAL
To print a single Arc Flash label, find the desired label and go through the File menu to 
choose Print. The Arc Flash Module also offers additional printing options, reached by 
selecting Print Special in the File menu.

•	Print All prints all of the labels in DuraSuite’s Arc Flash database.

•	Print Found Records prints all of the labels that match your current Search criteria and 
your current Project Filter, both described in the section “Finding a Saved Label,” above.

•	Print Custom opens a new window, allowing you to select labels from a list, and then 
prints all of the labels that you have chosen.

•	Print Die-Cut Sheets opens a new window to let you print using the DuraLabel Catalyst, 
which uses individual sheets of labels. Other DuraLabel printers use rolls of label stock, 
and this option will not be applicable.

Project Filter allows you 
to narrow your search to a 
single project.
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6. Pipe Markers
DuraSuite Labeling Software provides you with an automatic pipe marker design feature. 
You can also customize your pipe marker and add new pipe contents information as 
needed. 

To create an ammonia pipe marker, please refer to Section 7.1, “Creating an Ammonia 
Pipe Marker.”

6.1 Creating a Pipe Marker
The fastest and easiest way to create a pipe marker is by using DuraSuite’s automated 
features. New color displays correspond to the category of pipe marker you’re creating 
to help ensure you load the correct color of vinyl.

Please note that only information on the Pipe Marker tab is addressed in this section. 
For arrow wrap information, see “Arrow Wrap Tab” under Section 6.2.

6.1.1 AutoMAtiC PiPe MArker Design
To begin creating a pipe marker, click on the Pipe 
Markers image shown on DuraSuite’s opening 
splash menu. 

A new screen appears with two icons, one for pipe 
marking and one for ammonia pipe marking. Click 
on the Pipe Marking icon. (Ammonia pipe marking 
is discussed later in this guide, in Section 7.)

A pipe marker template appears with the Pipe Marker tab chosen.

Adding Content
Select your pipe’s contents from one of the four color-coded category menus at the top 
of the screen. Your selection appears in the Text field and display area. 

note: Each drop-down menu is color-coded to identify a content category. Use the 
same vinyl and ribbon color as the colors shown on the pipe content menu.

Pipe Marking icon

Pipe Markers icon

Select pipe contents from four color-coded category menus

Content appearing in the 
pipe marker template’s 
Text field also appears in 
the display area.
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If your pipe’s contents are not listed in one of the drop-down menus, enter your pipe’s 
contents in the Text field.

Now select an arrow style from the template to indicate 
the flow direction. Determine whether you want the 
arrow to appear on the left side, right side or both sides 
of the pipe contents, then click the circle next to the 
chosen option.

Next, select the pipe’s outside diameter from the “Outside Pipe 
Diameter Including Covering” drop-down menu. The outside 
diameter setting automatically sets the pipe’s “Supply Width,” 
“Font Height” and “Label Length” (as specified by ANSI code). 

Labels can be printed in either landscape or portrait format. 
Use the Stock Orientation buttons to select the orientation 
you want for your pipe label. 

note: “Text To Label” Automatic Resizing is not supported by the Portrait format.

note: A pipe marking label can be saved as a .pmlx file and loaded by either double-
clicking the file or using the File > Open menu.

6.1.2 CustoM sizing
DuraSuite Labeling Software lets you customize the size 
of your label’s text.

Click none in the “Automatically Resize” box, 
then change the dimensions in the “Supply 
Width,” “Font Height” and “Label Length” 
fields to the sizes you want.

If the settings you chose do not create an 
acceptable label appearance, click the reset 
button to automatically set text and label size.

Clicking None in the Automatically Resize box lets you 
adjust your label’s dimensions.

DuraSuite pipe marking module reset button
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6.1.3 Printing PiPe MArkers

note: Label colors are shown as reminders of the correct ribbon and supply color to 
load. The print preview will always be monochrome.

You can print two styles of pipe markers using DuraSuite Labeling Software: 

1. Pipe markers designed to be wrapped around the pipe provide information on 
both sides of the pipe. To print this type of pipe marker, click the box next to “Pipe 
Wrap”  to place a checkmark in the box. This displays a second 
checkbox labeled “Top.”

 ◦ If you click the Top box, a label designed to be wrapped over the top of the pipe 
will be printed.

 ◦ If you leave the Top box unchecked, a label designed to be wrapped around the 
bottom of the pipe will be printed.

Pipe marker designed to be wrapped 
around the top of a pipe

Pipe marker designed to be wrapped around the bottom of a pipe

2. Pipe markers with a single line of text 
are the more commonly used type of pipe 
marker. They allow placement of a label on 
one side of a pipe. If two sides of a pipe 
need to be marked, two pipe markers are 
used, one on each side.

Pipe marker designed with a single line of text
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Printing PiPe MArker SignS
You may also choose to print your 
Pipe Marker as a segmented sign. 
Select File > Print special > Print 
sign from DuraSuite’s main menu. A 
Print sign dialog box appears. Select 
your DuraLabel printer and supply 
width, then click Properties. 

A Properties dialog box appears. Click 
on the stock tab and select After Job from the 
occurrence drop-down menu, then click ok.

Your DuraLabel printer will print a page-per-
letter pipe marker, cutting at the end of the 
label.

note: The Pipe Wrap option is not supported 
by the Print Sign feature.

6.2 Arrow Wrap tab
DuraSuite lets you create custom arrow wraps 
for use with pipe marking. Click on the Arrow 
Wrap tab to get started. The Arrow Wrap screen appears, displaying a preview window 
with colored arrow wrap to let you know the correct supply color to load.

Print Sign dialog box

“After Job” cut setting under Stock tab

The Arrow Wrap tab includes a preview, which 
automatically updates as information is adjusted.

Arrow Wrap tab

1. Choose pipe diameter (including covering) from the drop-down menu. 

2. Change measurement unit as desired using Units drop-down menu.
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3. Populate the following information fields: 

Wrap Width–arrow wrap supply width

Wrap Length–arrow wrap length, typically the pipe’s outer diameter including 
covering

Arrow Count–number of arrows to be placed within arrow wrap’s length (number of 
arrows determines arrows’ thickness)

Arrow Spacing–amount of space between arrows (affects arrows’ thickness)

Arrow Width–arrows’ width (affects wrap margins)

4. Choose an arrow style. 

To print your arrow wrap, refer to the printing directions in Section 10, “Printing Labels.”
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7. Ammonia Pipe Markers
You can set up your ammonia pipe marker’s base label by using preset configurations or 
entering custom label information. Information included in this module is based on IIAR 
standards.

7.1 Creating an Ammonia Pipe Marker
The Ammonia Pipe Marking module consists of three tabs: the Base Label tab, the 
Physical State/Pressure Templates tab and the Arrow Wrap tab.

7.1.1 AMMoniA PiPe MArker DeSign
To begin creating a pipe marker, click on the 
Pipe Markers image on DuraSuite’s opening 
splash menu. 

A new screen appears with two icons, one for 
pipe marking and one for ammonia pipe marking. 
Click on the Ammonia Pipe Marking icon. An 
ammonia pipe marker template appears.

Ammonia Pipe Marking icon

Pipe Markers icon

Ammonia pipe marker template 
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Base LaBeL TaB
The Base Label tab lets you input size and layout criteria for your ammonia pipe marker. 

Placeholders can be added as guides for adhering labels to pipe markers. A placeholder 
for an arrow wrap may also be added on the base label.

A. Set Pipe Diameter: To build an ammonia pipe marker, first insert the diameter 
of your pipe, including covering. Choose from the list of preset configurations or 
enter your own values. All values must be greater than zero for your ammonia pipe 
marker to preview properly.

B. Choose Marker Type: Choose between Pipe Marker and Component Marker. If Pipe 
Marker is selected, choose the appropriate abbreviation from the Abbreviations list 
provided. If Component Marker is selected, choose the appropriate component from 
the Components list provided.

Edit or add to the Abbreviations or Components list by clicking edit List.

C. Physical State: Choose from Liquid, Vapor or Both placeholders by clicking the 
button next to your choice.

D. Pressure Level: Choose between the High or Low placeholder by clicking the button 
next to your choice.

e. Arrow Print options: Choose from Do Not Print Arrows, Print Placeholders for Arrow 
Wrap, or Print Arrows on Base Label by clicking the button next to your choice.

F. Arrow Locations: Place arrows on the left side, right side or both sides of the 
ammonia pipe marker by clicking the button next to your choice.

g. Arrow Style/Arrow Wrap Placement Direction: Choose from the list of arrow 
styles. If you are printing placeholders for arrow wraps, choose the desired direction 
of the arrow wraps.

A
B

C

D

e

g

F



DuraLabel.com | 800.788.5572    7.1 Creating an Ammonia Pipe Marker | 39

ammonia pipe markers

Print the marker before proceeding to the next tab. For additional information on printing 
see Section 10, “Printing Labels”.

PhysicaL sTaTe/Pressure TemPLaTes TaB

Select the Physical State/Pressure Templates tab. The physical state and pressure level 
labels indicate the color stock needed to ensure IIAR compliance, as well as the total 
size of each label. Click the corresponding physical state or pressure level template, 
then print. For additional information on printing see Section 10, “Printing Labels”.

noTe: Ensure your DuraLabel printer is loaded with corresponding supply to print each 
part of the ammonia pipe marker.

arrow wraP TaB
Please refer to Section 6.2, “Arrow Wrap Tab”, for more information on how to create 
custom arrow wraps.
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8. Label Designer
The Label Designer module is a powerful system for creating customized label designs. 
The tools in Label Designer make it well-suited for producing templates or sets of labels.

To open the Label Designer module, choose Label Designer in DuraSuite’s opening menu.

Label Designer

1. Open: Find and open a saved label design.

2. Change Label Size: Adjust the size and orientation of the current design.

3. Cut: Remove the selected content, to be pasted into place later.

4. Copy: Copy the selected content, to be pasted into place later.

5. Paste: Place the Cut or Copied content onto the label canvas.

6. Undo: Cancel your previous change.

7. Redo: Restore a change that you recently canceled.

8. Import Data: Turn your completed design into a series of labels, using data from a 
spreadsheet.

9. Set Location/Size: Specify an object’s exact location and size on the label.

10. Center Horizontally: Align an object to the horizontal center of the label canvas.

11. Center Vertically: Align an object to the vertical center of the label canvas.

12. Bring to Front: Make the selected object appear in front of any other objects.

13. Send to Back: Make the selected object hide behind other objects.

13 17 19 21 23 25 27 29 31 331
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8.1 Navigating the Label Designer

8.1.1 LaBeL DeSIgNeR TOOLBaR
At the top of the window, just below the general DuraSuite toolbar, the Label Designer 
module has its own toolbar for common actions.
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14. align Left edges/align Centers/align Right edges: With multiple objects selected, 
move them horizontally so that their left edges, centers, or right edges are aligned.

15. align Tops/align Middles/align Bottoms: With multiple objects selected, move 
them vertically so that their top edges, middles, or bottom edges are aligned.

16. Font: Choose the font and style for a text object, and set the text size in points (as 
in common word processing programs).

17. Font In Inches: Choose the font and style for a text object, and set the text size in 
inches.

18. Set Text: Type the static contents of a Text Label object.

19. edit Item List: Edit the sequential contents of a Text Label, Selection Box, or Text 
Box object.

20. Shapes: Select the type of shape for a Shape object.

21. Set Image: Choose an image file for an Image object.

22. Flip Vertically: Mirror the selected object vertically.

23. Flip Horizontally: Mirror the selected object horizontally.

24. Rotate: Rotate the selected object around its center.

25. Set Line Width: Choose the thickness of the lines on a Polygon or Shape object.

26. Set Polygon Sides: Choose the number of sides for a Polygon object.

27. Set Numeric Range: Choose the range and increment values for a Numeric 
UpDown object.

28. Barcode Options: Choose a barcode type and enter static or sequential data for 
barcodes.

29. Transparent: Remove or restore the blank background on the selected object.

30. Negative: Invert the colors of the selected object (white to black, and black to 
white).

31. Multiline: Toggle the display of multiple lines of text in a Text Box object.

32. Text alignment: Choose the alignment of text (left, center, or right) in a Text Box, 
Numeric UpDown, or Barcode object.

33. Text Scaling: Toggle the automatic resizing of text in a Text Label or Text Box object.
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8.1.2 LaBeL DeSIgNeR TOOL BOx
In the lower right corner of the window, the Tool Box shows the 
different objects that can be added to your design.

1. Image: Add a custom image, such as a company logo.

2. Date Picker: Choose a calendar date to be displayed on 
your label.

3. Shape: Add a simple shape, such as a rectangle or ellipse.

4. Polygon: Add a complex shape, such as a pentagon or 
octagon.

5. Text Label: Add a single line of static or sequenced text.

6. Selection Box: Create a dropdown menu for your label 
template, and fill it with text of your choice.

7. Numeric UpDown: Add a numeric counter that automatically increments with each 
print.

8. Text Box: Add a larger section of static or sequenced text.

9. Barcode: Add a linear or 2D barcode to show static or sequenced data.

8.1.3 THe LaBeL CaNVaS
The main part of the Label Designer window is the canvas, with a white rectangle 
representing your label and a gray or orange background to give you additional working 
space.

1
2
3
4

5
6
7
8
9

The label canvas.
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Zoom Controls
You can zoom in to see part of your label design in more detail, or zoom out to see 
more of the design at once. The Zoom slider bar is in the lower right corner of the Label 
Designer window; slide it to the right to zoom in, or to the left to zoom out. You can 
also control the zoom level by holding the Ctrl key on your keyboard and scrolling the 
mousewheel; scroll up to zoom in, or scroll down to zoom out.

non-Printing BaCkgrounds
For some designs, it may be helpful to have a reference image appear as a non-printing 
background. To set a background image, right-click on any empty part of the label 
canvas or border, and choose Set Background Image from the menu. The image will be 
stretched to fit the size of the label.

To remove the non-printing background image, right-click on any empty part of the label 
canvas or border, and choose Clear Background Image from the menu.

design mode and edit mode
Label Designer uses two modes to make it easy to create a template, and then modify 
the label content without accidentally changing the layout.

Design Mode (the default) allows you to add, move, and resize objects on the label. 
When Label Designer is in Design Mode, the background around your label will be dark 
gray. 

Edit Mode allows you to change the content of Text Box, Date Picker, Selection Box, 
and Numeric UpDown objects without allowing you to move or resize them. When Label 
Designer is in Edit Mode, the background around your label will be orange.

To switch between Design and Edit modes, click the  Edit Label button on the 
DuraSuite main toolbar, select Edit Mode from the Edit menu at the top of the screen, or 
use the keyboard shortcut Ctrl + E.

8.1.4 FILe CONTROLS
While the other modules of DuraSuite work with internal databases of information, Label 
Designer creates an individual file for each design, much like common word processing 
software.
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starting new designs and oPening saved designs
When you start the Label Designer module, a smaller window will appear, prompting you 
to set a new label’s dimensions or open an existing label. To start designing a new label, 
enter the desired details and click OK; to open a saved label, click the Open button.

To create a new label when the Label Designer module is 
already running, click the  

 New Label button on the DuraSuite main toolbar, select New 
from the File menu, or use the keyboard shortcut Ctrl + N. If 
there are unsaved changes to the current design, you will be 
prompted to save them.

To open a saved label when the Label Designer module is 
already running, click the  Open button on the Label Designer toolbar, select Open 
from the File menu, or use the keyboard shortcut Ctrl + O. Again, if there are unsaved 
changes to the current design, you will be prompted to save them.

saving a design
To save the current label design, click the  Save Label button on the DuraSuite main 
toolbar, select Save from the File menu, or use the keyboard shortcut Ctrl + S.

If you have not already saved the label, or if you choose Save As from the File menu, a 
new window will open for you to enter a file name and choose the file’s location.

8.2 Designing a Label Template
Every new label design is blank. The contents of the label will be added as objects from 
the Tool Box, and then moved, modified, and filled in.

8.2.1 BaSIC OBjeCT CONTROLS
To add an object to your design, drag it from the Tool Box onto the label. The new object 
will appear with placeholder information.

To select an object that has been placed, simply click on it. The object that is currently 
selected will be surrounded by a selection box. You can also select more than one object 
at a time by holding the Ctrl key on your keyboard while you click on the objects you 
want to select. To deselect all objects, click in an empty space on the design.

To move an object, drag the top or left edge of its selection box. The mouse cursor 
will change to show a four-direction arrow. You can move several objects together by 
selecting them all first.

To resize an object, drag the bottom or right edge, or the lower-right corner, of its 
selection box. The mouse cursor will change to show a two-direction arrow. Only one 
object can be resized at a time.

Set Document Size window
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You can also set the exact size and position of an object with the Set Location/Size 
tool. Select the object and click the  Set Location/Size button in the Label Designer 
toolbar, or right-click on the object and choose Set Location/Size from the menu.

To remove an object, select it and press the Delete key on your keyboard.

8.2.2 OBjeCTS ON THe LaBeL
Each type of object is used for a different purpose, and has slightly different controls.

image
An Image object can be a custom image or graphic, such as a company logo or a pictogram.

A freshly-placed Image object will appear as a black square. To set the source file for 
an image, select the object and click the  Set Image button in the Label Designer 
toolbar, or right-click on the object and choose Set Image from the menu. To set an 
image, you need to be in Design Mode (with the gray border around your label design.)

DuraSuite can use the following image formats: .BMP, .JPG, .JPEG, .JPE, .GIF, .TIF, .TIFF, 
.PNG, .ICO, .SVG, .WMF, and .EMF.

date PiCker
A Date Picker object shows a calendar date in a consistent format, and lets you easily 
choose different dates for different labels.

A freshly-placed Date Picker object will show the current date (as it is set on your 
computer). To change the date, you need to be in Edit Mode (with the orange border 
around your label design). Once in Edit Mode, you can type new numbers into the 
month/day/year fields, or click the arrow button to choose a date from a calendar.

To change the font or text size, select the Date Picker object and click the  Font 
button or the  Font In Inches button in the Label Designer toolbar, or right-click on 
the object and choose Font or Font In Inches from the menu.

shaPe
A Shape object adds a basic geometric shape to the design, which can be helpful for 
creating borders or attracting attention. Shapes are available as rectangles, ellipses, or 
triangles, and can be filled or unfilled.

A new Shape object will be an unfilled rectangle. To change the shape, select the object 
and click the  Shapes menu button in the Label Designer toolbar, or right-click on the 
object and choose Shapes from the menu. Each of these approaches will show a list of 
shapes to choose from. You can also adjust the thickness of the shape’s outline; click 
the  Set Line Width button in the Label Designer toolbar, or right-click on the object 
and choose Set Line Width from the menu. To make these selections, you need to be in 
Design Mode (with the gray border around your label design.)
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Polygon
A Polygon object adds a more complex geometric shape to the design, with a designated 
number of sides. Like Shapes, a Polygon can be filled or unfilled.

A new Polygon object will be an unfilled pentagon. To set a different number of sides, 
select the object and click the  Set Polygon Sides menu button in the Label Designer 
toolbar, or right-click on the object and choose Set Polygon Sides from the menu. To 
choose a filled or unfilled shape, right-click on the object, choose Shapes from the 
menu, and select either Filled Polygon or Polygon (unfilled). You can also adjust the 
thickness of the polygon’s outline; click the  Set Line Width button in the Label 
Designer toolbar, or right-click on the object and choose Set Line Width from the menu. 
To make these selections, you need to be in Design Mode (with the gray border around 
your label design.)

text laBel
A Text Label object shows a single line of text, such as a header or title. Text Labels can 
also be sequenced, making them change automatically from one label to the next.

A new Text Label object will show the phrase “Blank Label.” To change the text, you 
need to be in Design Mode (with the gray border around your label design.) Select the 
object and click the  Set Text button in the Label Designer toolbar, or right-click on 
the object and choose Set Text from the menu.

To change the font or text size, select the Text Label object and click the  Font button 
or the  Font In Inches button in the Label Designer toolbar, or right-click on the object 
and choose Font or Font In Inches from the menu. You can also toggle the Text Scaling 
option to automatically squash or stretch the text to fit in its box; select the object and 
click the  Text Scaling button, or right-click on the object and choose Text Scaling 
from the menu.

seleCtion Box
A Selection Box object lets you select one line of data from choices that you have typed 
in. Selection Boxes can also be sequenced, making them change automatically from one 
label to the next.

A new Selection Box object will be blank. To add new options, you will need to be in 
Design Mode (with the gray border around your label design.) Right-click on the object 
and choose Edit Selection Box Item List from the menu. Each selection will appear on its 
own line in this window, with a new option added each time you enter information and 
press Enter. You can use the buttons on the left side of this window to move an option 
up or down in the sequence, or to delete an option.

To choose which option is shown, you will need to be in Edit Mode (with the orange border 
around your label design.) Once in Edit Mode, you can use the election box as a drop-down 
menu, by clicking on the down arrow and then selecting your desired line of text.



DuraLabel.com | 800.788.5572    8.2 Designing a Label Template | 47

LabeL Designer

To change the font or text size, select the Selection Box object and click the  Font 
button or the  Font In Inches button in the Label Designer toolbar, or right-click on 
the object and choose Font or Font In Inches from the menu.

numeriC uPdown
A Numeric UpDown object shows a numeric value. By default, Numeric UpDown objects 
are sequenced, making them count up automatically from one label to the next.

A new Numeric UpDown object will show 0, and then count up to 10 (with an increment 
of 1) as labels are printed. To set the range and increment, select the object and click 
the  Set Numeric Range button in the Label Designer toolbar, or right-click on the 
object and choose Set Range from the menu. To set these details, you need to be in 
Design Mode (with the gray border around your label design.)

The object will automatically count up when you print a label, but if you would like to set 
it to a different point, you need to be in Edit Mode (with the orange border around your 
label design.) Then, you can type a new value in the box, or use the up and down arrows 
to choose a current setting.

To change the font or text size, select the Numeric UpDown object and click the  Font 
button or the  Font In Inches button in the Label Designer toolbar, or right-click on 
the object and choose Font or Font In Inches from the menu.

text Box
A Text Box object displays a section of text that can span more than one line. Text Boxes 
can also be sequenced, making them change automatically from one label to the next.

A new Text Box object will show the phrase “Text Box.” To change the text, you need to 
be in Edit Mode (with the orange border around your label design.) Once in Edit mode, 
click anywhere in the text box and type your desired text. You may need to return to 
Design Mode (with the gray border) to adjust the size of the object, as text that will not 
fit cannot be shown.

By default, Text Boxes are set to “Multiline,” which makes text continue on a new line 
when it reaches the end of the box; if you only want one line of text to appear, disable 
the Multiline option by clicking the  Multiline button in the Label Designer toolbar, or 
right-click on the object and choose Multiline from the menu.

To change the font or text size, select the Text Box object and click the  Font button 
or the  Font In Inches button in the Label Designer toolbar, or right-click on the object 
and choose Font or Font In Inches from the menu. You can also toggle the Text Scaling 
option to automatically squash or stretch the text to fit in its box; select the object and 
click the  Text Scaling button in the Label Designer toolbar, or right-click on the object 
and choose Text Scaling from the menu.
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BarCode
A Barcode object encodes data to be readable with a scanner or computer system. 
Barcodes can also be sequenced, making them change automatically from one label to 
the next.

A new Barcode object will show the number 1, using the Code 39 barcode type, and 
with a human-readable version of that data displayed below the code. To change any of 
these elements, you need to be in Design Mode (with the gray border around your label 
design.) Select the object, click the  Barcode Options button in the Label Designer 
toolbar, and choose Data Editor, or right-click on the object and choose Edit Barcode 
from the menu. This will open a new window. You can type the desired information on 
the left side of this Barcode Configuration window, and choose barcode options on the 
right, with a preview in the lower part of the window. Because labels with barcodes are 
often needed in a sequence, this window can accept different lines of information for 
different labels, as described in the section on Automatically Updating Content later in 
this guide.

DuraSuite can use the following barcode formats: Code 39, Code 128, PDF 417, QR 
Code, Code 128 A/B/C, and DataMatrix.

8.2.3 aDDITIONaL OBjeCT CONTROLS
In addition to moving and resizing objects by hand, Label Designer allows for more 
advanced controls. 

Centering oBjeCts on the design
To move an object to the horizontal or vertical center of the label design, select the 
object and click the  Center Horizontally or  Center Vertically button in the Label 
Designer toolbar, or right-click on the object and choose Center Horizontally or Center 
Vertically from the menu. If multiple objects are selected, these functions will center the 
group as a whole, not each item individually.

ordering layers of oBjeCts
When objects on the design overlap, it may be necessary to adjust the stacking order 
of those objects. To pull an object in front of any others, select it and click the  Bring 
to Front button in the Label Designer toolbar, or right-click on the object and choose 
Bring to Front from the menu. To push an object behind any others, use the  Send to 
Back button in the toolbar, or the Send to Back option in the object’s right-click menu. If 
multiple objects are selected, these functions will reorder all of the objects.
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aligning oBjeCts together
To align a group of objects so that their edges or centers line up, select the objects that 
you want to move. Then, click one of the group alignment buttons on the toolbar:  

 align Left edges,  align Centers,  align Right edges,  align Tops,  
 align Middles, or  align Bottoms. The objects will shift to match your choice; you 

may want to move the group as a whole once the objects are aligned.

fliPPing and rotating oBjeCts
To flip or mirror an object, select it and click either the  Flip Vertically button or the 

 Flip Horizontally button in the Label Designer toolbar, or right-click on the object and 
choose Flip Vertically or Flip Horizontally from the menu. To rotate the object, choose a 
rotation from the  Rotate menu button in the Label Designer toolbar, or right-click on 
the object and choose a rotation from the Rotate options in the menu. If multiple objects 
are selected, these functions will flip or rotate each item individually, and not the group 
as a whole.

making oBjeCts transParent or negative
Most objects appear with a white background in their selection boxes. To clear an 
object’s white background so that other objects can show through, select the object and 
click the  Transparent button in the Label Designer toolbar, or right-click on the object 
and choose Transparent from the menu. You can also choose to invert the colors of the 
object, turning white to black and black to white; for this, select the object and click the 

 Negative button in the Label Designer toolbar, or right-click on the object and choose 
Negative from the menu.

8.3 automatically Updating Content
The real power of the Label Designer module is in automatically creating batches of 
labels that use a single design, like the arc flash labels or the GHS labels in those 
modules. To accomplish this, Label Designer lets you create “sequences,” which make 
an object show one piece of information on one printed label and a different piece of 
information on another label.

The different objects that can have dynamic values are noted in the Tool Box as 
“Sequenceable.” Text Label, Selection Box, Numeric UpDown, Text Box, and Barcode 
objects are all sequenceable.

There are two ways to set up the information that will change from one label to another. 
You can manually enter the information for each object on the design that needs to 
change, or you can import data from a spreadsheet or other data source.
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8.3.1 MaNUaLLY SeTTINg UP a SeQUeNCe
Each sequenceable item can have its sequence set manually, using an object-specific 
menu.

For Text Label, Selection Box, and Text Box objects, select the object and click the  
 edit Item List button in the Label Designer toolbar, or right-click on the object and 

choose Edit Item List from the menu. A new window will appear, where you can type the 
content for each label on its own line. You can also rearrange the lines using the arrow 
buttons on the left, or remove unwanted lines with the “X” button. Press Enter on your 
keyboard to start a new label’s content. When finished, click Done.

For Barcode objects, select the object, click the  Barcode Options button in the 
Label Designer toolbar, and choose Data Editor, or right-click on the object and choose 
Edit Barcode from the menu. This will open a new window for the assorted barcoding 
options. Here, you can type the content for each label on its own line. You can also 
rearrange the lines using the arrow buttons at the bottom of the list, or remove 
unwanted lines with the “X” button. Press Enter on your keyboard to start a new label’s 
content. When finished, click Finish.

For Numeric UpDown objects, the data is simply a number that counts up. To set the 
range and increment, select the object and click the  Set Numeric Range button in 
the Label Designer toolbar, or right-click on the object and choose Set Range from the 
menu.

8.3.2 IMPORTINg DaTa FROM a SPReaDSHeeT
Rather than entering sequenced data manually, you may import data from a 
spreadsheet or similar data source. This is especially helpful when multiple elements 
need to change from one label to the next. For this type of import, DuraSuite can accept 
spreadsheets in .CSV (Comma-Separated Values), .XLS (Microsoft Excel), or .MDB 
(Microsoft Access) file types. DuraSuite can also use an ODBC connection to pull data 
from a variety of database systems, although this advanced connection option may 
require assistance from your IT department.

Before you start the import process, ensure your spreadsheet is formatted properly. 
It is often best to use the first row of data for column headers; after that, each new 
row should correspond to a specific piece of equipment, with no blank rows. Your 
label design should also be complete, with objects in place for all of the data that you 
want the label to include. It is often helpful to use filler information to ensure that the 
template will hold all the information you need.

When ready to import data, click the  Import Data button in the Label Designer 
toolbar. Select the file or connection type, and click the Choose Source button to select 
your spreadsheet or data source. If you are using the ODBC option, you will need to 
select a user or system Data Source Name (DSN) or enter a connection string.
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On the next screen, you will see your design on the left, with each sequenceable object 
marked with a selection box. On the right will be a list of column headers from your 
data source, with the information from your data source shown at the bottom of the 
window. Drag and drop each column header to the sequenceable object where that data 
belongs. Some column headers may be used more than one, and others may not be 
used at all, depending on your label design and spreadsheet contents. When finished 
with this step, click the Next button to continue.

A sample label will show you how data has been imported, so you can check that 
information is going to the right places. If something is wrong, you can use the Previous 
button at the bottom of the window to go back a step and correct the problem. Use the 
directional arrows at the bottom of the window to preview different labels. When finished 
with this step, click Finish to continue. DuraSuite will automatically create a sequence 
for your chosen objects with the selected data.

8.3.3 CHOOSINg a LaBeL aND PRINTINg
Once a sequence has been created, the arrow buttons on the DuraSuite main toolbar 
will be active. You can click on the arrow buttons to cycle through the labels in your 
sequence. If an item is selected, the arrow buttons will change only that item.

When ready to print, go through the File menu to Print as normal. If you want to print 
more than one of your labels at once, use the “Page Range” option to choose the labels 
in the sequence that you want to print, such as “1 through 4.”
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9. Tools 

NoTe: This section does not apply to the DuraLabel Catalyst. For DuraLabel Catalyst 
printing instructions, please refer to the DuraSuite supplemental guide included with 
your DuraLabel Catalyst printer.

This section describes how to align items, select font style, replace a 
database and perform other related functions.

9.1 Tools Menu
The Tools drop-down menu displays Calibration and options. 

9.1.1 CalibraTioN
To calibrate your label, click on Calibration on the 
Tools drop-down menu and select Calibration. A 
Calibration dialog box appears.

In Calibration mode you move the text and 
images on the label up/down or left/right to 
align the printing on a label.

Use the arrows to move the label’s text and 
image. An example preview appears in the 
window to the right of the arrows.

NoTe: Calibration is not available in Label Designer module. If label elements do not 
print where intended within this module, they may be shifted manually.

9.1.2 opTioNs
Options allows you to select a default font style, turn on and off the DuraSuite opening 
splash menu or print labels in full color. Click on options and a Module settings dialog 
box containing two tabs appears.

Calibration shift is demonstrated within dialog 
box with an example label image.
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AppeArAnce TAb
The appearance tab lets you select DuraSuite’s default 
font style. Click on the appearance tab to display a list 
of font styles. 

Select the font you prefer for the default style. A preview 
of the selected font is displayed below the list. Click the 
oK button to save your selection and close the Module 
Settings dialog box. The text on the displayed label will 
change to the new font.

preferences TAb
The preferences tab contains a checkbox for activating 
or deactivating a splash menu that appears when 
opening DuraSuite Labeling Software. 

If you don’t want the splash menu to appear when 
opening your software, remove the checkmark by 
clicking it.

Module Settings’ Appearance tab 

Module Settings’ Preferences tab
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10. printing labels

NoTe: Section 10, “Printing Labels” does not apply to the DuraLabel Catalyst. For 
DuraLabel Catalyst printing instructions, please refer to the DuraSuite supplemental 
guide included with your printer.

To preview the label before printing, click File, then 
Print Preview on the menu bar. If you’re satisfied with 
how the label looks, close the Print Preview window.

To print your label(s) click File, then Print. A Print 
dialog box opens. Select the appropriate printer and 
click Preferences button. A Printing Preferences 
dialog box appears. Next, click the Stock tab and 
select the media settings (continuous or die-cut 
labels). Then set the Post-Print Action (Cut) and 
Occurrence.

Up to 99 labels can be printed at a time. Printing 
selections default to a quantity of 1 (as well as to 
other original settings) with each printing job.

10.1 Quick print
To print with only one click, click the Quick Print button on the toolbar. The currently 
displayed label prints using the most recent settings.

NoTe: Changes made in printer preferences under Printers and Faxes on your 
computer (Windows XP) or Devices and Printers (on later Windows versions) may affect 
DuraSuite even while the program is running.

10.2 print special
Click File, then print special from the menu bar. 
A selection box appears with options to: “Print All,” 
“Print Current Selection” or “Print Custom.”

10.2.1 priNT all
Click print all to print every label in the database for 
the selected module. A dialog box appears asking 
if you want to print all labels. Click either “Yes” or 
“No.”

Choose your DuraLabel printer
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10.2.2 priNT CurreNT seleCTioN
Print Current Selection prints all labels in the current Search/Project.

10.2.3 priNT CusToM
Print Custom displays a choice of RTK label 
chemicals and substances. In the “Available” 
section highlight the label(s) you want to 
print. Using the top arrow, move the selected 
labels from the Available section to the 
Selected section.

Click oK when all the desired labels have 
been selected. One of each label you 
selected will be printed.

To adjust where the information is printed on the label, see Section 9.1.1, “Calibration.”

10.2.4 priNT sigN
Print Sign selection will print a page-per-letter or page-per-length. To print a sign, click 
File, then Print Special, then Print Sign. A Print Sign dialog box opens. Enter the width of 
the supply you will use and click oK. The DuraLabel printer will print as many strips as 
necessary to complete the entire sign. For instance, if you design a 12" x 16" label and 
are printing on 4" wide label supply, your printer prints four 12" x 4" labels from which 
you can create a 12" x 16" sign. You also have the option to set page overlap to assist 
with alignment.

10.3 printing photos or Colored images
If a photograph or colored image has been used on the 
label, you’ll need to set the dithering. Dithering converts 
the continuous tones of a photograph into the black and 
white dots printed by printers, such as 
DuraLabel thermal transfer printers.

After selecting the printer, click 
Preferences. A Printing Preferences 
dialog box appears. Click the Graphics 
tab and select the Dithering option 
you want. Most labels with images 
print best with at least halftone 
dithering chosen.

Printing Preferences dialog box
with the Stock tab selected

Printing Preferences 
dialog box with the 
Graphics tab selected
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